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Bab III Metode Penelitian 

 

III.1 Lokasi dan Waktu Penelitian 

Gambar 3.1 menunjukkan lokasi penelitian ini yang berada pada stockpile 

Gurimbang Mine Operation PT Berau Coal yang terletak di Kecamatan 

Sambaliung, Kabupaten Berau, Provinsi Kalimantan Timur. Luas Area of Interest 

(AOI) penelitian ini adalah 18,25 hektar, pada penelitian ini menggunakan 12 ICP. 

 

Gambar 3. 1 Lokasi Penelitian 

 

Waktu pelaksanaan dan penyusunan penelitian tugas akhir dengan judul 

“Pemanfaatan Unmanned Aerial Vehicle (UAV) Metode PPK (Post-Processing 

Kinematic) untuk Perhitungan Volume Stok Batubara di Stockpile PT Berau Coal 

Kalimantan Timur Tahun 2024” dirincikan dalam tabel 3.1. 
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Tabel 3. 1 Waktu Pelaksanaan Penelitian 

NO Nama Kegiatan 

Tahun 2024 

Februari Maret April Mei Juni Juli Agustus 

1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 

1 Tahap Persiapan                                                       

  a. Identifikasi Masalah                                                       

  b. Studi Literatur                                                       

  c. Perizinan                                                       

2 Tahap Pengumpulan Data                                                       

  a. Foto Udara                                                       

  b. Data RINEX                                                       

  c. Koordinat ICP                                                       

  d. Data Bedding Surface Stockpile Area                                                       

  e. Data Timbangan Batubara                                                       

3 Tahap Pengolahan Data                                                       

  a. Pengolahan PPK                                                       

  b. Pengolahan Foto Udara                                                       

 c. Pengolahan Filtering                            

 d. Perhitungan Volume Batubara                            

4 Tahap Analisis                                                       

  a. Uji Ketelitian Geometri                                                       

  b. Uji Validitas                                                        

5 Tahap Pelaporan Akhir                                                       

  a. Pelaporan                                                       

  b. Revisi                                                       
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III.2 Alat dan Bahan 

III.2.1 Alat 

Tabel 3. 2 Alat yang Digunakan 

Alat 

Perangkat Keras Fungsi 

UAV WingtraOne GEN II Alat UAV yang digunakan untuk 

akuisisi data di lapangan 

GNSS Receiver Trimble R8 Alat yang digunakan untuk 

pengambilan data koordinat titik ICP di 

lapangan 

CORS Trimble Alat yang digunakan sebagai base 

station untuk PPK dan rover  

Perangkat Personal Computer (PC) Alat yang digunakan untuk 

pengolahan, analisis dan penyajian data 

Alat Tulis Kantor Peralatan yang digunakan dalam 

pencatatan kegiatan pengukuran di 

lapangan  

Perangkat Lunak Fungsi 

WingtraHub Aplikasi yang digunakan untuk proses 

geotagging 

Agisoft Aplikasi yang digunakan dalam proses 

pengolahan foto udara 

RiSCAN PRO Aplikasi yang digunakan untuk proses 

filtering  

Minescape Aplikasi yang digunakan untuk 

perhitungan volume stok batubara 

QGis Aplikasi yang digunakan untuk 

layouting peta 

Microsoft Office Aplikasi yang digunakan untuk 

membuat laporan 
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III.2.2 Bahan 

Tabel 3. 3 Bahan yang Dibutuhkan 

No Bahan Keterangan Format Data 

1 Foto udara hasil 

pengukuran 

menggunakan UAV 

WingtraOne 

Luas Area Of Interest 

(AOI): 18,25 ha, tinggi 

terbang 200 m, sidelap dan 

overlap 70%, jarak tempuh 

7.44 km, waktu tempuh 8 

menit 45 detik, GSD 2.7 

m/piksel 

*.jpg 

2 RINEX file dari 

CORS 

Data RINEX dari Base 

CORS untuk proses PPK 

RINEX File 

3 Koordinat titik uji 

yang diperoleh dari 

pengukuran langsung 

di lapangan 

Data pengukuran pada 12 

titik ICP menggunakan 

GPS RTK Trimble R8 

*.csv 

4 Data bedding surface 

stockpile area 

Data dasar tumpukan 

batubara yang digunakan 

sebagai data bottom 

surface dalam perhitungan 

volume batubara 

*.dgn 

5 Data timbangan 

batubara 

Record timbangan data 

muatan batubara yang 

diangkut oleh dump truck  

Tonnase 
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III.3 Diagram Alir Penelitian 

 

 

Gambar 3. 2 Diagram Alir Penelitian 



39 

Megarani Tri Shintadevi, 2024 
PEMANFAATAN UNMANNED AERIAL VEHICLE (UAV) METODE POST-PROCESSING KINEMATIC 
(PPK) UNTUK PERHITUNGAN VOLUME STOK BATUBARA DI STOCKPILE  PT BERAU COAL 
KALIMANTAN TIMUR TAHUN 2024 
Universitas Pendidikan Indonesia I repository.upi.edu I perpustakaan.upi.edu 

 

Gambar 3. 3 Diagram Alir Penelitian 
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III.4 Pelaksanaan Penelitian 

III.4.1 Tahap Persiapan 

Tahap persiapan mencakup studi literatur, di mana peneliti melakukan 

pencarian literatur yang relevan dengan topik penelitian. Studi literatur ini dapat 

dilakukan melalui buku, jurnal, skripsi yang tersedia di perpustakaan, atau sumber-

sumber lain. Tujuan dari studi literatur ini yaitu untuk mengumpulkan sebanyak 

mungkin referensi yang terkait dengan topik penelitian. Selain itu, pada tahap ini 

juga dilakukan proses perizinan dengan PT Berau Coal.  

III.4.2 Tahap Pengumpulan Data 

Setelah tahap persiapan selesai, maka tahap selanjutnya adalah tahap 

pengumpulan atau akuisisi data menggunakan UAV dan GNSS. Data yang 

diperlukan dalam penelitian ini antara lain: 1) foto udara hasil pengukuran 

menggunakan UAV WingtraOne; 2) file RINEX dari CORS; 3) koordinat titik uji 

yang diperoleh dari pengukuran langsung di lapangan (ICP); 4) data permukaan 

penimbunan (bedding surface) area stockpile; dan 5) data timbangan batubara. Pada 

tahap ini melibatkan serangkaian langkah yang penting sebelum pelaksanaan 

pengukuran volume dilakukan, seperti menentukan lokasi yang akan dipetakan 

pada penelitian ini luas area of interest (AOI) 18,25 hektar, menentukan lintasan 

penerbangan, mengatur parameter penerbangan yang terdiri dari ketinggian 

penerbangan 200 meter, tumpang tindih (overlap) antara gambar-gambar yaitu side 

overlap 70% dan  front overlap 70%. Kamera yang digunakan adalah kamera Sony 

RX1 RII 42 MP dengan focal length 35 mm, ketinggian terbang 200 meter dan 

ukuran pixel 0,0047 mm, menghasilkan nilai GSD 2,7 cm/piksel. Sebelum 

melakukan akuisisi data di lapangan, terlebih dahulu dibuat rencana jalur terbang. 

Pembuatan rencana jalur terbang menggunakan perangkat lunak WingtraHub, 

ditunjukkan pada Gambar 3.5.  
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Gambar 3. 4 Rencana Jalur Terbang 

Akuisisi foto udara di stockpile Gurimbang Mine Operation (GMO) 

menggunakan alat ukur UAV metode PPK dilakukan pada tanggal 30 Juni 2024. 

Akuisisi foto udara dilakukan menggunakan UAV VTOL WingtraOne GEN II 

dengan estimasi waktu flight plan selama 8 menit 45 detik pada ketinggian 200 

meter dari lokasi take-off.  

III.4.3 Tahap Pengolahan Data  

A. Pengolahan Data PPK 

Proses pengolahan data PPK dimulai dengan men-download data RINEX 

base station. Posisi setiap foto udara dikoreksi melalui PPK menggunakan base 

CORS SMO milik PT Berau Coal untuk memastikan konsistensi sistem referensi 

koordinat. Proses ini dilakukan dengan software WingtraHub, di mana sistem 

referensi koordinat yang digunakan adalah sistem koordinat geografis WGS 

1984 dengan ketinggian ellipsoid yang dikonversi menjadi ketinggian 

berdasarkan referensi model geoid EGM 96.  

Sebelum melaksanakan proses image matching, dilakukan geotagging, 

yaitu penambahan informasi koordinat pada foto. Data yang diperlukan untuk 

geotagging meliputi foto udara dan data RINEX. Perangkat lunak yang 

digunakan dalam proses ini adalah WingtraHub. Tujuan geotagging adalah 

untuk menyelaraskan koordinat pada foto udara. 
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B. Pengolahan Foto Udara 

1. Tahapan pengolahan foto udara menggunakan Agisoft Metashape 

Professional dimulai dari import foto udara CPP GMO hasil geotagging 

dengan WingtraHub. Foto udara yang telah disinkronkan dengan 

koordinat hasil olahan PPK dimasukkan ke dalam workspace melalui 

menu workflow.  

2. Tahap kedua yaitu align photos dimana perangkat lunak mencari titik-

titik yang sesuai antara foto-foto yang tumpang tindih. Setelah itu, 

perangkat lunak memperkirakan posisi kamera untuk setiap foto dan 

membangun model sparse point cloud. 

3. Tahap ketiga yaitu optimize camera, yang berfungsi untuk 

mengkalibrasi parameter kamera foto guna mengurangi kesalahan pada 

foto udara. Proses optimize camera merupakan proses untuk 

mendapatkan akurasi yang lebih baik, maka dari itu optimize camera 

harus dilakukan.  

4. Tahap keempat yaitu input GCP atau georeferencing yang berfungsi 

untuk menghubungkan sistem koordinat hasil proses align photos 

dengan sistem koordinat pada permukaan bumi melalui titik-titik acuan.  

5. Tahap kelima adalah build point cloud, yang melanjutkan output dari 

align photos berupa sparse point cloud. Fungsi dari build point cloud 

adalah untuk merepresentasikan titik-titik dalam ruang tiga dimensi, 

menjadikannya lebih rapat dengan representasi unsur RGB yang lebih 

baik.  

6. Tahap berikutnya adalah build DEM, yang menggambarkan elevasi 

permukaan bumi secara digital dalam format raster. 

7. Tahap terakhir adalah build Orthomosaic, yang menghasilkan gambar 

hasil image matching yang telah diproses sehingga saling bertumpang 

tindih dan memiliki proyeksi ortogonal. Pembangunan orthophoto 

menggunakan DEM sesuai dengan pengaturan parameter pada pilihan 

surface. 
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C. Pengolahan Filtering 

Output dari build point cloud pada pengolahan data menggunakan 

perangkat lunak Agisoft Metashape Professional ialah data point cloud. Filtering 

data di aplikasi RiSCAN PRO pada perhitungan volume batubara adalah untuk 

memastikan bahwa data point cloud yang digunakan dalam analisis benar-benar 

representatif dan bebas dari noise atau kesalahan. Pada data yang belum diproses 

filtering seluruh objek yang terdapat di permukaan bumi baik vegetasi, 

bangunan, jalan dan lainnya ikut tersaji dalam raster image. Dalam perhitungan 

volume stok batubara, data yang diperlukan adalah surface tumpukan batubara. 

Oleh karena itu perlu dilakukan proses filtering untuk menghilangkan objek 

seperti jalan, bangunan, vegetasi. 

D. Pengolahan Perhitungan Volume Batubara 

Menghitung volume stok batubara menggunakan software minescape 

bertujuan untuk mengetahui estimasi cadangan stok batubara yang ada pada 

stockpile. Berikut ini tahapan-tahapan dalam proses perhitungan volume stok 

batubara: 

1. Proses untuk perhitungan volume dimulai dengan import data yang sudah 

melalui tahapan filtering.  

2. Proses boundary volume data CPP GMO dengan cara digitasi manual 

menggunakan tools polygon sesuai dengan area masing-masing. Tujuan 

proses boundary yaitu membuat batasan area yang akan dilakukan 

pembuatan triangle. 

3. Tahapan selanjutnya adalah proses triangle data CPP GMO sebagai top 

surface. Triangle merupakan proses pembentukan TIN sebagai data surface 

yang akan digunakan untuk proses perhitungan volume dan pembuatan 

kontur.  

4. Setelah proses triangle top surface selesai selanjutnya adalah membuat 

bottom surface melalui proses triangle bottom data CPP GMO. Pembuatan 

bottom surface terdahap data bedding yang merupakan lantai dasar ROM 

stockpile. Bedding coal yang digunakan terdiri dari reject coal sehingga 

batubara tidak terkontaminasi langsung dengan tanah.  
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5. Tahapan selanjutnya adalah proses contouring menggunakan data hasil 

triangle. Kontur diperlukan untuk menampilkan gambaran 3D masing-

masing stok batubara.  

6. Langkah terakhir adalah proses mengitung volume data CPP GMO dengan 

menggunakan menu open cut. Open cut merupakan metode perhitungan 

volume yang ada pada software Minescape. Dengan metode ini maka data 

cutt dan fill dapat terhitung secara keseluruhan. Pada menu reserves lalu pilih 

volumes maka akan muncul tampilan reserves calculate volume, pada 

jendela ini pilih type nett volumes, design file, beri nama polygons, input 

triangle file, beri nama tabel file pada output. Jika proses calculate volume 

sudah selesai, hasil calculate dapat dilihat dengan cara klik kanan pada tabel 

file lalu view. Maka akan muncul tampilan hasil dari calculate nett volumes.  

III.4.4 Tahap Analisis 

Tahap analisis merupakan proses penting untuk memastikan bahwa hasil 

perhitungan volume batubara yang dilakukan akurat dan dapat diandalkan. Analisis 

pada penelitian ini dilakukan terhadap hasil uji ketelitian dan uji validasi data. Pada 

tahap uji ketelitian terdapat uji ketelitian horizontal menggunakan persamaan 2.15 

dan uji ketelitian vertikal menggunakan persamaan 2.16 dengan cara 

membandingkan koordinat (titik) yang diperoleh dari hasil pemrosesan foto udara 

(koordinat foto) dengan koordinat yang diukur secara langsung di lapangan (ICP). 

Hasil analisis uji akurasi horizontal dan vertikal harus memenuhi ketelitian kelas 1 

pada skala 1:1000 sesuai dengan SNI 9135-1:2022. Selanjutnya pada tahap uji 

validasi data dilakukan dengan cara menghitung persentase deviasi antara hasil 

UAV PPK dengan data volume timbangan menggunakan persamaan 2.17. Hasil 

analisis uji validasi harus menunjukkan nilai deviasi kurang dari 2% sesuai dengan 

ASTM. 

III.4.5 Tahap Akhir 

Penyusunan laporan merupakan tahap akhir dalam penelitian ini. Laporan 

yang disajikan dengan jelas dan terstruktur. Pada tahap ini, hasil penelitian disajikan 

dalam beberapa tahapan yaitu metodologi yang digunakan, analisis data, dan 

interpretasi hasil. Laporan ini bertujuan untuk memberikan gambaran menyeluruh 
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mengenai proses perhitungan volume batubara, validasi hasil, serta rekomendasi 

dan saran untuk meningkatkan akurasi dan efektivitas metode pengukuran yang 

digunakan. Penyusunan laporan mencakup pembuatan dokumen tertulis yang 

mendetail dan visualisasi data untuk mendukung tahapan dan hasil penelitian.  

III.5 Tutorial Penggunaan Software  

Pengolahan data pada penelitian ini menggunakan 4 jenis software yang 

berbeda, yaitu software WingtraHub yang digunakan untuk geotagging, software 

Agisoft Metashape Professional yang digunakan dalam pengolahan data foto udara, 

software RiSCAN PRO yang digunakan dalam pengolahan filtering, dan software 

Minescape yang digunakan dalam pengolahan surface dan perhitungan volume stok 

batubara.  

III.5.1 Geotagging pada Aplikasi WingtraHub 

1. Pada proses geotagging menggunakan perangkat lunak WingtraHub. 

Sebelum melakukan geotagging dilakukan pengunduhan data RINEX 

terlebih dahulu. Proses pengunduhan data RINEX adalah sebagai berikut: 

a) Pilih Base SMO 

b) Pilih tahun 2024; 

c) Pilih bulan 6; 

d) Pilih tanggal pengambilan data yaitu 30; 

e) Download dan Save data sesuai jam pengambilan data. 

 

Gambar 3. 5 Proses Pengunduhan Data RINEX 
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2. Setelah data RINEX sudah diunduh, Open aplikasi WingtraHub > Klik 

Geotagging > masukkan folder projects di WingtraPilotProjects Folder.  

 

3. Masukkan folder CPP GMO > klik select folder > select all > next.  

 

4. Unchecklist bagian output geotagging image lalu masukkan base file yang 

digunakan yaitu data yang telah diunduh di rinex dan base location yang 

digunakan merupakan data CORS SMO lalu start Geotagging. 

 

Gambar 3. 6 Proses Geotagging 
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III.5.2 Pengolahan Foto Udara pada Aplikasi Agisoft 

1. Open software Agisoft > add data foto udara, klik workflow > add folder > 

pilih folder CPP GMO > Select folder 

 

2. Import data hasil geotagging.  

a) Klik reference; 

b) Import lalu masukan data hasil geotagging;  

c) Pada jendela import CSV, perhatikan coordinate system pastikan 

semuanya telah sesuai lalu klik Ok; 

d) Akan muncul berupa point  

 

Gambar 3. 7 Import data hasil geotagging 
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3. Selanjutnya proses align  photo.  

a) Workflow > align  photos; 

b) Pada jendela align photos pilih accuracy dan reference preselection > 

OK 

c) Jika proses align  selesai selanjutnya klik tools > optimize camera 

d) Jika muncul jendela optimize camera alignment klik OK, tunggu proses 

hingga selesai 

 

Gambar 3. 8 Proses align photos 

4. Proses selanjutnya adalah Import GCP.  

a) Sebelum import GCP harus mengubah coordinate system menjadi 

WGS84/ UTM zone 50N. Klik convert reference.  

b) Ubah coordinate system menjadi WGS84/ UTM zone 50N > Ok 

c) Import reference 

d) Piilih file GCP > klik open 
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Gambar 3. 9 Import GCP 

5. Koreksi foto dengan data GCP dengan cara klik kanan pada GCP > filter 

photos by markers 

 

6. Jika proses GCP telah selesai selanjutnya kembali ke optimize camera > 

tools > optimize camera > OK 

 

7. Setelah itu lanjut untuk melihat Generate Report hasil dari akurasi posisi 

GCP. Klik File > Export > Generate Report > OK 
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Gambar 3. 10 Export Generate Report 

8. Selanjutnya adalah proses build point cloud.  

a) Workflow > build point cloud  

b) Pada jendela build point cloud pilih quality yang akan digunakan > OK 

 

Gambar 3. 11 Build Point Cloud 

9. Setelah proses build point cloud selesai selanjutnya export data dengan cara 

klik workspace > klik tanda panah kebawah > pilih data point cloud dan klik 

kanan > export point cloud  
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10. Pada jendela save pilih format dalam bentuk (*.dxf) >save  

 

11. Selanjutnya akan muncul jendela Export Points. Pastikan coordinate system 

yang digunakans sesuai, lalu pada source data  pastikan yang dipilih yaitu 

point cloud > Ok, tunggu hingga proses save selesai 

  

12. Proses build DEM.  

a) Workflow > build DEM   
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b) Pada jendela build DEM pastikan system coordinate sudah sesuai, 

pastikan source data pilih point cloud > OK 

 

Gambar 3. 12 Build DEM 

13. Proses Orthomosaic.  

a) Workflow > Build Orthomosaic  

b) Pada jendela build orthomosaic pastikan system coordinate sudah 

sesuai, pastikan surface pilih DEM, pastikan pixel size X 0.1 dan Y 0.1 

sesuai dengan kebutuhan > OK 

 

Gambar 3. 13 Build Orthomosaic 



53 

Megarani Tri Shintadevi, 2024 
PEMANFAATAN UNMANNED AERIAL VEHICLE (UAV) METODE POST-PROCESSING KINEMATIC 
(PPK) UNTUK PERHITUNGAN VOLUME STOK BATUBARA DI STOCKPILE  PT BERAU COAL 
KALIMANTAN TIMUR TAHUN 2024 
Universitas Pendidikan Indonesia I repository.upi.edu I perpustakaan.upi.edu 

14. Setelah proses Orthomosaic selesai selanjutnya export data dengan cara klik 

workspace > klik tanda panah kebawah > pilih data orthomosaic dan klik 

kanan > export orthomosaic 

 

15. Pilih format (*.tif) > Save  

 

16. Pada jendela export orthomosaic yang perlu diperhatikan yaitu system 

coordinate yang digunakan telah sesuai dan pixel size diubah sesuai 

kebutuhan menjadi X 0.1 Y 0.1 > OK 
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III.5.3 Filtering Data pada Aplikasi RiSCAN PRO 

1. Buka aplikasi RiSCAN PRO > klik Project > pilih new  

 

2. Pilih lokasi penyimpanan data > beri nama project file name: 

GMO_24M06_CPP > Save 

 

3. Akan muncul tampilan project manager > pilih POLYDATA > klik kanan 

pilih import 
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4. Muncul tampilan import data lalu pilih data yang digunakan yaitu 

240630_CPP GMO > Open 

 

5. Akan muncul tampilan import LAS file > Ok 

 

6. Selanjutnya akan muncul tampilan POLYDATA yang telah dibuat 

240630_FS12 > Tarik data yang telah di import ke layar > maka akan 

muncul tampilan Select view type > Ok 

 

7. Akan muncul tampilan data foto udara 240630_FS12 yang belum rapih atau 

masih terdapat vegetasi, bangunan, jalan dll. 
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8. Select data > pilih fitur terrain filter > pada jendela terrain filter pilih 

setting: Mining-objects > kemudian Ok, maka vegetasi akan terhapus 

 

9. Selanjutnya klik kanan pada POLYDATA > pilih create new polydata 

 

10. Akan muncul tampilan create new polydata > pada jendela data, pilih all 

data > Ok 



57 

Megarani Tri Shintadevi, 2024 
PEMANFAATAN UNMANNED AERIAL VEHICLE (UAV) METODE POST-PROCESSING KINEMATIC 
(PPK) UNTUK PERHITUNGAN VOLUME STOK BATUBARA DI STOCKPILE  PT BERAU COAL 
KALIMANTAN TIMUR TAHUN 2024 
Universitas Pendidikan Indonesia I repository.upi.edu I perpustakaan.upi.edu 

 

11. Pada jendela settings > centang Octree > ganti increment (m) X dan Y (1) 

menjadi 0,75 > Output name: CPP_24M06 masukkkan nama data yang 

dikerjakan > Ok 

 

12. Pada POLYDATA cpp_24m06 klik kanan > Export 
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13. Maka akan muncul tampilan Export data > pilih penyimpanan > beri nama 

file name cpp_24m06 > pilih save as type: ASCII (.txt) > Save 

 

14. Jika sudah klik save maka akan muncul tampilan Export as ASCII (.txt) > 

klik Ok 
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III.5.4 Perhitungan Volume pada Aplikasi Minescape 

1. Buka aplikasi Minescape 2023 > pilih project name = 2024_GMO (sesuai 

tempat menyimpan data yang akan diproses) 

 

2. Double klik pada project name = 2024_GMO, maka akan muncul tampilan 

layar minescape 2023 

 

3. Proses Export data CPP_GMO 240630. Klik kanan pada menu Design Data 

> New Design File > Beri nama cpp_2406 > klik Ok 
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4. Klik kanan pada design file cpp_2406 > import from ASCII > Pilih file 

name yang akan diproses dengan format *.txt > pilih cpp_24m06.txt 

 

5. Pada kolom format pilih “xyzuser” lalu klik kanan dan pilih edit 

 

6. Pada jendela feature format sesuaikan dengan kolom data pengukuran pada 

cpp_24m06.txt 

 

7. Pada deck output, pilih kolom design file cpp_2406 > dan beri nama 

CPP_24M06_TOP pada kolom layer 
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8. Pilih warna pada Display Definition > Class pilih Points dan centang 

Annotate User Data > Every Vertex > Ok 

 

9. Maka akan muncul data CPP_24M06_GMO sesuai design yang telah dibuat  

 

10. Proses Triangle data CPP_24M06 GMO (TOP). Pada Layout “Display” 

pilih design file “cpp_24m06_top” > klik kanan > pilih Select 
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11. Klik menu “Mesh” > Klik Create Surface. Akan muncul tampilan surface 

> klik Ok 

 

12. Save Mesh. Pada deck Output > “Mesh Group” pilih “mesh_cpp_2024” > 

“Name” beri nama “cpp_24m06_top” Centang “Create Mesh Surface 

Definition” Deck Colour. Pilih warna mesh. Lalu klik Ok. 
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13. Pada menu Explorer pilih menu “Mesh” > lalu pilih mesh group 

“mesh_cpp_2024” > klik kanan pada layer “cpp_24m06_top” > pilih 

Convert to Triangulation. Akan muncul jendela confirm pilih Yes 

 

14. Proses Boundary data CPP_24M06 GMO. Pilih layer file yang telah dibuat 

“cpp_2406” klik kanan > New layer 

 

15. Pada Create New layer beri nama layer boundary: cpp_24m06_vol > Ok 
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16. Klik kanan pada layer “CPP_24M06_VOL” > pilih edit 

 

17. Digitasi manual menggunakan tools Polygon sesuai dengan area masing-

masing (RC1, RC2, FS1, FS2, FS3,) menggunakan snapping (ketik tombol 

“S” pada keyboard dan arahkan ke area yang akan dibuat polygon) lalu ketik 

tombol “Q” pada keyboard untuk finish polygon 

 

18. Proses Contour data CPP_24M06 GMO. Klik pada menu Home > lalu pilih 

Contour. Pada jendela Contour-Mesh pilih Contouring > Setup > pilih Input 

Mesh Group : “mesh_cpp_2024 pilih Layer : “cpp_24m06_top”. Output 

Design file : cpp_2406, Layer : “CPP_24M06_CNT” 
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19. Pada Graphis pilih Lines > pilih Use Intervals > masukkan angka 0.5 pada 

Contour Interval dan 5 pada Annotation Frequency > lalu klik Ok 

 

20. Proses Triangle data CPP_24M06 GMO (BOTTOM). Pada Layout 

“Display” pilih design file “cpp_24m06_bot” > klik kanan > pilih Select 
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21. Klik menu “Mesh” > Klik Create Surface 

 

22. Akan muncul tampilan surface > pilih polygon masing-masing area lalu 

ketik “Q” pada keyboard > Ok 

 

23. Save Mesh. Pada deck Output > “Mesh Group” pilih “mesh_cpp_2024” > 

“Name” beri nama cpp_24m06_bot”. Centang “Create Mesh Surface 

Definition” Deck Colour. Pilih warna mesh > Lalu klik Ok 
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24. Pada menu Explorer pilih menu “Mesh” > lalu pilih mesh group 

“mesh_cpp_2024” > klik kanan pada layer “cpp_24m06_bot” > pilih 

Convert to Triangulation > Pada jendela Confirm pilih Yes 

 

25. Proses menghitung volume data CPP_24M06 GMO. Klik Surface 

Engineering >> dari “CAD” menjadi “Open Cut” 

 

26. Pilih menu Reserves > Volume. Maka akan muncul jendela Reserves 

Calculate Volume 
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27. Pada jendela Reserves Calculate Volume pilih Reserves Calculate Type > 

Nett Volumes > Input Polygons > Design File pilih “cpp_2406” > Beri nama 

pada Polygon Name di masing-masing area (RC1,  RC2, FS1, FS2, FS3) 

> Pick Element ID di masing-masing polygon dengan cara klik kanan pada 

kolom ID lalu pilih pick dan arahkan ke polygon yang ada di layar utama > 

Input Triangle File dan Layers > Output >> Tabel File isi dengan nama 

“volume_cpp_24m06_net” > Apply 

 

28. Jika proses calculate volume sudah selesai, hasil calculate dapat dilihat 

dengan cara klik kanan pada Tabel File lalu pilih View 

 

29. Maka akan muncul tampilan hasil dari calculate Nett Volumes. Lalu pilih 

Open in Excel pada menu Tabel Editor 
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III.6 Pengujian Penelitian 

Pengujian akurasi posisi menggunakan nilai RMSE yang merupakan nilai 

perbedaan antara titik uji dengan titik sebenarnya. Proses uji ketelitian posisi 

dilakukan dengan membandingkan koordinat yang diperoleh dari hasil pemrosesan 

foto udara (koordinat foto) dengan koordinat yang diukur secara langsung di 

lapangan. Dimana RMSE horizontal diperoleh dengan membandingkan koordinat 

x,y ICP di lapangan dengan koordinat  x,y di foto, menggunakan persamaan 2.11. 

Untuk RMSE vertikal diperoleh dengan membandingkan koordinat z ICP di 

lapangan dengan koordinat  z di foto, menggunakan  persamaan 2.14. Dengan cara 

ini, posisi yang diperoleh dari foto udara dapat dievaluasi untuk menentukan 

seberapa akurat posisinya dibandingkan dengan kondisi sebenarnya di lapangan. 

Ketelitian horizontal ditunjukkan oleh nilai CE90, yang dihitung menggunakan 

Persamaan 2.15, sedangkan ketelitian vertikal ditunjukkan oleh nilai LE90, yang 

dihitung menggunakan Persamaan 2.16. 

Luas Area of Interest (AOI) pada penelitian ini adalah 18,25 hektar. 

Berdasarkan SNI 8202:2019, uji ketelitian posisi menggunakan 12 titik ICP. Jumlah 

titik uji berdasarkan luasan sesuai dengan dengan SNI 8202:2019 dapat dilihat pada 

tabel 3.4. Jumlah titik uji ditetapkan secara spesifik berdasarkan luas area, dengan 

angka yang meningkat seiring dengan bertambahnya luas area. Sebagai contoh, 

untuk area ≤250 km² dibutuhkan 12 titik uji, sementara untuk area 2.251-2.500 km² 

dibutuhkan 60 titik uji. Jumlah titik uji untuk ketelitian vertikal disesuaikan antara 

area vegetasi dan non-vegetasi. 

Tabel 3. 4 Jumlah ICP Sesuai dengan SNI 8202:2019 

Luasan (Ha) Jumlah titik ICP 

≤ 25.000 12 

25.100 – 50.000 20 

50.100 – 75.000 25 

75.100 – 100.000 30 

100.100 – 125.000 35 

125.100 – 150.000 40 

150.100 – 175.000 45 
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Luasan (Ha) Jumlah titik ICP 

175.100 – 200.000 50 

200.100 – 225.000 55 

225.100 – 250.000 60 

 

Perbandingan SNI 8202:2019 dengan SNI 9135-1:2022 metode Indirect 

Georeferencing jumlah GCP dan ICP tidak ditetapkan secara tetap melainkan 

berdasarkan bentuk dan kebutuhan AOI. Sebagai contoh, untuk AOI berbentuk 

persegi panjang (2,4 km x 1,2 km) yang terdiri dari 2 subblok dan 1 blok 

pengolahan, dibutuhkan minimal 5 GCP yang tersebar di sepanjang perimeter dan 

tengah AOI. Pada penelitian ini menggunakan 12 ICP yang mengikuti ketentuan 

pada SNI 8202:2019. 

 Selanjutnya dilakukan tahap uji validitas terhadap nilai perhitungan 

persentase deviasi ukuran antara hasil UAV PPK dengan data volume timbangan 

yang diperoleh dari hasil pengukuran data timbangan tiap muatan yang dibawa oleh 

dump truck. Standar nilai deviasi berdasarkan American Society for Testing and 

Materials (ASTM) yaitu harus kurang dari 2% dengan menggunakan persamaan 

2.17.  


